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1.0 WELCOME TO SIASCOPY - SIMSYS 
 
This document contains important information regarding the safe operation of 
the SIMSYS SIAscopy system. 
 

Read through the entire operating guide before using the SIAscope 
handset or SIMSYS software for the first time.  It describes the 
installation, set-up and use of the SIMSYS software with the SIAscope 
and provides important safety information. 
 
Before operating the SIMSYS software and the SIAscope it is 
imperative that the user has received proper training and is familiar 
with the Cautions and Warnings section of the manual. 
 
Contact SIAscans are intended to be used as an aid to diagnosis.  The 
user must understand the meaning and implications of SIAscans 
before attempting to use them clinically. Clinical White Papers written 
by independent scientists and clinicians describing how SIAscans can 
aid diagnosis are available from MedX Health Corp. (MedX). 

 
 

1.1 System Components 
 
The following components should be included with your SIMSYS SIAscopy 
system: 
 

 SIAscope V Model Handset Scanner 

 Base Stand 

 SIMSYS Software Installation (on CD or USB memory stick) 

 SIAscope Calibration Data (on CD or USB memory stick) 

 Clinical Training (on CD or USB memory stick) 

 Clinical Training Guide 

 SIMSYS Operating Guide (this booklet) 

 SIMSYS Installation Guide 

 USB Licence Key 

 USB Cable 

 Matching Fluid 

 Lens Cleaning Cloth 
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1.2 Indications for Use  
 
The SIAscope, together with the SIMSYS software, is a non-invasive system 
used to analyse skin conditions and skin health.  It provides colour bitmaps 
called ‘SIAscans’ that show the relative location and concentration of blood, 
collagen, melanin and dermal melanin within the papillary dermis and/or 
epidermis. 
 
The device is for external application only and should only be used to scan a 
patient’s skin. 
 
The device is intended for professional use only in general clinical examination 
room environments. 
 
Contra-indications 
 
The SIAscope should NOT be used under the following conditions: 
 

 Over open wounds or sores, 

 Directly over a pacemaker. 

 On skin or lesions containing light absorbing pigments (see Warnings). 
 
 

1.3 How SIAscans Provide Information on Skin Histology  
 
Unlike biopsy, the SIAscans use patented SIA technology to provide an array of 
quantitative measurements that are displayed in graphical form creating a 
synthesized ‘image’ showing how the parameter varies spatially over the skin 
area.  
 
Contact SIAscans provide information about:  
 

 Concentration: The relative concentration of various skin components, 
including pigment (such as melanin), blood and collagen, in the plane 
of the skin.  

 Location: The location relative to the dermal / epidermal junction of 
selected components. 

 
Each contact SIAscan isolates a single component viewed over an 
approximately 11mm diameter area and displays it as a colour bitmap.  



 

SIMSYS Operating Guide (760-00SS-0001) 3 

  

1.4 SIMSYS 
 
SIMSYS allows you to bring SIAscopy into consultations within your practice. 
SIMSYS is designed as an introduction to SIAscopy (our skin imaging 
technology) that is backed up with the Hunter scoring system; also know as the 
‘Primary Care SIAscopy Algorithm’.  Developed by Dr. Jude Hunter and first 
presented in poster format at the British Association of Dermatology 2006 
titled 
 

“The diagnostic characteristics of SIAscopy versus dermoscopy 
for pigmented skin lesions presenting in primary care”, 

 
SIMSYS has been designed for the clinician that is not an expert in either 
SIAscopy or Dermoscopy but who wants to increase diagnostic accuracy as well 
as patient satisfaction within lesion specific consultations. 
 
SIMSYS has been designed to help you identify some common benign lesions, 
as well as identify features in suspicious lesions.  With SIMSYS as a diagnostic 
tool to back up your clinical expertise along with the patient history you can 
reassure both yourself as well as your patients that the correct course of action 
has been taken. 
 
The Hunter scoring system presents specific questions regarding the captured 
SIAscan. The questions are aimed at assisting you to identify specific features 
within the lesion that are visible using SIAscopy.  Any presence of these 
features in melanin, dermal Melanin, blood or collagen views can be key 
indicators regarding the status of the lesion.  After progressing through the 
Hunter scoring system a recommendation will be displayed to aid your 
diagnosis. 
 
After regular use, you may find that you do not need to use the scoring system 
and simply assess the SIAscans looking at other characteristics within the 
individual views, therefore improving your sensitivity and specificity for 
suspicious lesions even further. 
 
Further information regarding SIMSYS, clinical papers or any of MedX’s 
products can be found at the following website: 
 

http://www.medxhealth.com/ 
 

http://www.medxhealth.com/
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1.5 SIAscope Handset 
 
The SIAscope handset used in conjunction with SIMSYS captures detailed 
SIAscans of the skin.  The centre button marked SIA is used to capture a 
SIAscan.  The four buttons with the directional arrows are not used with the 
SIMSYS program. 
 
 
 
 
 
 
 
The centre button also lights up blue indicating that the SIAscope is on. 
 
The SIAscope is designed such that it uses a USB 2.0 cable and USB2.0 or 3.0 
port on the computer.  This is particularly useful as the SIAscope can be 
unplugged and transported along with the Computer to a different room or 
even a different building without involving any complicated set up each time. 
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1.6 Labelling Symbols and Markings 
 

 

Use-by date 

 

Serial number 

 

Keep dry 

 

Fragile, handle with care 

 

Temperature limit 

 

Humidity limitation 

 

Caution 

 

Consult instructions for use 

 

Type BF applied part, device 
makes physical contact with 

patient  

Class II electrical device 

 

Recycle separately from 
other waste 

 

Manufacturer 

 
Batch Code 

 

Authorized representative in 
European Community 

 

2.0 CAUTIONS AND WARNINGS  
 

 
The SIAscope V is for EXTERNAL USE ONLY and should not be used on 
open wounds or sores. 
 
The SIAscope V is not to be used over a pacemaker. 
 
The SIAscope V is intended for use by healthcare professionals only.  
The SIAscope V may cause radio interference or may disrupt the 
operation of nearby equipment.  It may be necessary to take 
mitigation measures, such as reorienting or relocating the equipment 
or shielding the location. 
 
The SIAscope does not generate a significant source of electro-
magnetic interference.  However, the system is not intended for use in 
areas of high electro-magnetic radiation (e.g. MRI). 

http://www.google.ca/url?sa=i&rct=j&q=class+ii+symbol&source=images&cd=&cad=rja&docid=WR39d_R8XzQOIM&tbnid=RMnDqbUlQllxHM:&ved=0CAUQjRw&url=http://www.ebme.co.uk/arts/safety/part4.php&ei=COCcUduGOMjhyQG1o4DoBg&bvm=bv.46751780,d.aWc&psig=AFQjCNECmNBu_lLi1vn7gWf5JBnzFpi
http://en.wikipedia.org/wiki/File
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No modification of this equipment is allowed. 
 
The use of cables other than those specified, with the exception of 
cables qualified and sold by the manufacturer of the SIAscope V, may 
result in increased emissions or decreased immunity of the equipment 
and may cause the system to be non-compliant with the requirements 
of IEC 60601-1-2:2007. 
 
The SIAscope V should not be used adjacent to or stacked with other 
equipment and if adjacent or stacked use is necessary, the SIAscope V 
should be observed to verify normal operation in the configuration in 
which it will be used. 
 
In order to avoid cross contamination, the nosecone of the SIAscope 
must be cleaned between each patient use with an Isopropyl wipe. 
 
The SIAscope V emits light of wavelength 440-960nm.  Check with a 
patient’s existing treatments to ensure compatibility. 
 
 Do not look directly into the light from the SIAscope.  When scanning 
skin on a patient’s face, ensure that their eyes are closed. 
 
  
SIAscopy (Contact or Non-Contact) does not function correctly on skin 
or lesions containing light absorbing pigments including haemasiderin, 
eschar, scales, jaundice, tattoos, inks, cosmetics, and other conditions 
that give rise to the presence of unusual chemicals in the skin.  In very 
dark lesions such as some Seborrhoric Keratoses, Contact SIAscans 
may also give incorrect information.  In these special cases refer to 
MedX for advice. 
 
The SIAscope V needs special precautions regarding EMC and needs to 
be installed and put into service according to the EMC information 
provided in this document. 
 
Portable and mobile RF communications equipment can affect the 
SIAscope V. 
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Untrained or unqualified personnel must not use the system.  All users 
must read and understand these instructions fully before using the 
device. 
 
Printouts of SIAscans are intended for reference only as they are of 
reduced resolution and colours may not be reproduced accurately.  
Refer to SIAscans displayed in the SIMSYS software to view fully 
detailed SIAscans. 
 
Do not disconnect the SIAscope from the PC when it is scanning. 
 
 
The SIAscope contains no user serviceable parts.  Please contact MedX 
or your local distributor if your system requires maintenance. 
 
Take care in handling the SIAscope.  These pieces of equipment are 
liable to be damaged if dropped. 
 
Take care when packing/unpacking the equipment.  The SIAscope 
contains delicate components which should not be subjected to undue 
forces.  Take care to store each item carefully. 
 
It is up the clinician/operator to take proper measures in order to 
ensure appropriate security of patient information as the SIMSYS 
system does not incorporate any security features. 
 
Any measurements taken are for relative indication purposes only and 
are not to be considered as an accurate or precise measurement. 
 
To safely terminate operation, you should always close the SIMSYS 
application first by clicking on “X” in the upper right hand corner or by 
selecting Exit from File menu (File>Exit) before you unplug SIAscope V 
scanner and License Key from their USB ports. 
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3.0 OPERATING INSTRUCTIONS 
 
3.1 Connecting the SIAscope and USB Licence Key 
 

The SIMSYS software must be installed before proceeding with this section. 
 

(a) Plug the USB 2.0 cable into the SIAscope and into an available USB 2.0 
port on your computer. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(b) Plug the USB Licence Key into an available USB 2.0 port on the 

computer. 
 

 NOTE:  
 Both the SIAscope and License Key have to be plugged in at all times 

while running the SIMSYS program. 
 

 
 
 
 
 
 

Connect this end 
of the cable to 
the SIAscope V 

Connect this end 
of the cable to 
the computer 
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3.2 Starting SIMSYS 
 

To start the SIMSYS software, ensure that the Licence Key and SIAscope are 
plugged into the USB 2.0 ports before double clicking on the SIMSYS icon. It is 
recommended to always plug the License key and SIAscope into same ports 
as when they were originally installed. The software will open displaying the 
default Clinics page. Before you proceed with setting up your Clinic’s details 
you can select one of available software languages under “View>Language” 
menu. 
 

 
 

3.3 Setting Up a New Clinic  
 

Click on New and complete the on-screen form (see below) and then click OK.  
The details are automatically saved and the name of the clinic will now be listed 
in the Clinics window. 

 
 
Click Back to return to the Clinics page. 
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3.4 Patients  
 

3.4.1 Creating a New Patient Record  
 

To create a new patient record, select the appropriate clinic and click on New 
on the Patients screen. Enter as much data as you require into the form. The 
patient number is optional and determined by your own, existing patient 
records system or, for instance, a National Insurance number. Notes can be 
added directly into the Notes section at any stage. 

 

 
 

3.4.2 Accessing Patient Records  
 

Open the required Clinic.  All patients’ names or ID numbers associated with 
the Clinic selected are then displayed.  Highlight the name required and click 
Open. 
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For patient privacy, patients may be listed by number instead of name.  Click on 
the Show Names/Show ID to switch between options.  The Search function can 
also be used to locate patient records. 
 

3.4.3 Deleting a Patient Record  
 

Open the Clinic screen and select the appropriate clinic.  From the Patients 
screen select the name of the patient.  Click to highlight and click on Remove. 
Confirmation window will pop-up before deleting the patient files. 
 

3.5 Locating a Mole or Lesion on the Mannequin 
 

SIMSYS provides a mannequin onto which the exact location of the mole or 
lesion is recorded.  The mannequin gender is determined when the new patient 
record is created.  To create and locate a new mole or lesion record, under the 
Body map section, click on New to access the mannequin.  The following 
screen will appear. 
 

 
 
Moles or lesions can only be marked on the central mannequin view.  If the 
mole or lesion concerned is located on one of the alternative views, click on the 
alternative view which will then occupy the larger, central view.  Position the 
cursor on the location desired and Click.  The mole or lesion location will now 
be marked with a red dot.  Click OK to confirm.  A new mole or lesion record 
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has now been created; ready to be populated with images of the specific mole 
or lesion identified in the graphic and any associated documents.  
 

Note: 
If you have a wheel on your mouse you can zoom-in the central 
mannequin view for more precise locating of the lesion. 

 

3.6 Creating a New SIAscan of a Mole or Lesion 
 

Before conducting a scan clean the patient’s skin, removing cosmetics etc with 
a sterile swab. Check for unusual conditions that may adversely affect the 
performance of the SIAscope as described in the Cautions and Warnings 
section.  
 

(1)  Cleaning the SIAscope - Before each patient examination, wipe the end 
of the nosecone with an Isopropyl wipe and the Lens Cleaning Cloth 
provided.  

 
In order to avoid cross contamination, the SIAscope must be cleaned 
between each patient use. 
 

 (2)  Applying matching fluid - Apply optical matching fluid to the area of 
skin to be examined.  A single squirt from the applicator should be 
sufficient.  Should you need to order additional matching fluid please 
contact MedX or your local distributor. 

 
In order to obtain the best possible SIAscan it is essential that 
matching fluid is used whenever a SIAscan is taken. This is to help the 
light being emitted from the SIAscope to penetrate the skins surface. 
To apply matching fluid simply use the spray dispenser supplied to 
cover the area being examined with the SIAscope.  Do not apply too 
much matching fluid as this can cause bubbles to appear in the final 
image. It is well worth taking some time to practice how much is 
needed to achieve the best results. 
 
For best results, matching fluid recommended and supplied by the 
manufacturer should only be used. 
 
 
Do not apply matching fluid to open wounds or sores. 
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(3)  Start a New Scan - Within the Images section, click on New Scan. The 
SIAscope will now be active and begin to flash from the nosecone. Wipe 
the nosecone with an isopropyl wipe and follow the direction on the 
screen. 

 

(4)  Positioning the SIAscope - Apply matching fluid to patient’s skin and 
place the SIAscope on the patient. Using the on-screen viewfinder 
centre the handset on the lesion.  Press down lightly to prevent light 
from the room contaminating the scan.  

 

(5)  Acquiring a scan - Hold the handset still, then press and release the 
handset button and wait while the SIAscope takes the scan.  The 
software will indicate when scanning is complete. Ensure that the scope 
is held in place while the SIAscope logo on the screen turns. A tone will 
sound when the scan is complete and the scope can be removed. 

 

(6)   Review and accept – The colour view of the mole or lesion is then 
displayed alongside the four images. If you are satisfied with the quality 
of the image taken, click on Yes. 
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The SIAscan is then presented in a new window ready for assessment with the 
fade and zoom tools (see section 3.8).  If you wish to assess the lesion later, 
click on BACK to return to the lesion record/body map or select any other 
program location from the “bread crumb” menu located below the BACK 
button in upper right section of the window. 
 

 
 
 

Note: 
All fields entered under Highlights section will be printed in 
your PDF patient/detailed report (see section 3.11 Saving 
and Printing Reports) 

 
When the Diagnosis field is entered this will become name within the Body 
map thumbnail under the Body map section on the patient screen. 
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3.7 Correct Use of the SIAscope 
 

The following symptoms may indicate inaccurate use of the SIAscope, 
producing inconsistent contact SIAscans. Check the precautionary notes below 
and repeat the scan to ensure the SIAscans contain accurate indications.  
 

I. SIAscan contains unusual black edges  
II. Blotches on images  

III. Consecutive scans contain a similar mark or spot  
IV. Blood SIAscan appears patchy  
V. Colour view has green and red areas or featureless images  

VI. Unusual coloured dots in the SIAscan  
 

Refer to the Cautions and Warnings section for limitations relating to 
unusual skin pigmentation conditions such as jaundice, tattoos, inks 
and cosmetics. 

 

I. SIAscan contains unusual black edges 
 

A shadow effect around the edge of the scan area, normally on the Blood or 
Collagen SIAscans, is likely to have been caused by light ingress during 
scanning. To rectify the problem, repeat the scan ensuring the window on the 
handset is fully in contact with the skin to exclude light. 

 

II. Blotches on images 
 

Blotches may be caused by bubbles in the matching fluid.  The Blood SIAscan 
scan highlights these bubbles particularly well.  To rectify the problem, clean 
off the current layer of matching fluid, apply a thinner layer and re-take the 
scan. 

 

III. Consecutive scans contain a similar mark or spot 
 

A re-occurring mark or spot on the scans is likely to have been caused by dirt 
or debris on the window.  It is important to ensure that the window is always 
clean.  It is often difficult to spot this kind of problem when heavily featured 
or freckled areas are being scanned.  One method recommended to avoid this 
problem is to wipe the end of the handset after every scan with an Isopropyl 
wipe.  This serves to both clean and sterilize the window. 
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IV. The Blood SIAscan appears patchy 
 

A patchy Blood SIAscan is often a symptom of excessive pressure being 
applied to the skin. This pressure tends to whiten the skin surface pushing the 
blood into a blotched formation. 

 

V. Colour view has a green and red areas or featureless images 
 

This is most likely caused by handset movement during scanning.  Ensure that 
the lesion is steady on the viewfinder before starting a scan, and hold the 
handset in position until after the scan finishes.  Excessive use of optical 
matching fluid can make it difficult to keep the handset still. 

 

VI. Unusual coloured dots in the SIAscan  
 

In some circumstances SIMSYS cannot process the data collected. In areas 
where this occurs the SIAscans contain bright dots, which are easily 
distinguishable.  Such scans should be retaken.  If the dots appear 
consistently ensure that the skin is clean and free of cosmetics.  Refer to the 
Cautions and Warnings section. 
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3.8 Using SIMSYS Tools to Assess a Mole or Lesion 
 

SIMSYS provides tools to aid an accurate assessment of the mole or lesion. 
 

Zoom In/Out - The zoom slider bar is located to the right hand side of the 
screen.  The zoom function can also be used with the Blood, Melanin, Dermal 
Melanin and Collagen views. 
 

 
 

To view the lesion in one of the specific views, click on the icons to the left of 
the page until yellow highlighting bars appear around the title. 
 
Using the Fade colour in/Fade colour out slider to the right of the screen, the 
colour view can be wholly or gradually removed to enable the blood, melanin 
and collagen views to be seen in isolation or superimposed onto the colour 
view. 
 
Using the Rotate slider will rotate the image. This is particularly useful when 
comparing images as it is easy to line them up as the positioning of the scanner 
will probably not be exactly the same when taking follow up scans. 
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The Mark feature will allow you to place a marker on the scan. This tool will 
allow the clinician to identify specific area of concern within the mole/lesion 
with a marker (circle or arrow). To add the marker use the Insert key on your 
keyboard or left click on Mark and then select Add mark. Configure the marker 
type by selecting desired options in the pop-up window  
 

 
Figure: Mark editing pop-up window 

 

This will place marker on the scan in all five views. To move the marker into 
desired position use centre/top mark-end icon (little blue square icon) – place 
the mouse over this point, left-click and drag. To change the size of the marker, 
place the mouse over the bottom mark-end icon (another little blue square 
icon), left-click and drag to change the size. To save the selections use the 
Escape (Esc) key on your keyboard or click on Mark and select Stop editing 
marks.  
To Remove or Edit already added/saved marker, left-click on Mark and select 
Edit marks. This will bring back mark-end icons (two little blue squares icons) 
on the marker. Place the mouse over either one of mark-end icons (little blue 
square icons) and right-click to open new menu (see bellow). 
 

 
 
Select Remove mark which will remove the marker from all five SIAscan views, 
or select Edit mark which will open the Mark editing pop-up window to make 
any desirable changes. Click on the Escape (Esc) key on your keyboard or select 
Stop Editing marks to save the changes you have made. 
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View of melanin distribution 

View dermal melanin levels 

View collagen indicators Collagen 
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3.9 Compare SIAscans in Parallel or Overlay 
 

SIMSYS allows the comparison of two images taken of the same mole or lesion.  
 

From the mole or lesion record, select the two images that are to be compared 
by clicking on the first image, then push and hold down the CTRL key and select 
the second image by clicking on it.  Both images will now be highlighted with a 
green border.  
 

Click on the Compare button.  The two images will be displayed in Overlay. 
Click on Hide newer to zoom in the older image first, and then click on Show 
newer to zoom in and line up newer image. Rotate feature will come in handy 
at this point to achieve the closest possible “alignment” of the two scans. 
 

 
 

 
 

 

Use the function tools on the top left side of the screen to change view from 
Overlay to Parallel View.  

Overlay View 
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Note: In a mole or lesion record that contains 2 or more SIAscans of the same 
mole or lesion, an automatic graph of the blood, collagen and melanin levels of 
the separate images is displayed. 
 

 
 

3.10 Scoring a SIAscan 
 

SIMSYS offers three standard scoring systems used with a Dermatoscope to 
assess a mole or lesion: 

1. Primary Care Scoring System, 
2. 7 Point Scoring System, 
3. 3 Point Scoring System. 

In the patient record, click on a SIAscan and click on Score.  Choose which 
system to use and then follow the on-screen instructions to complete the 
assessment. 

Parallel View 
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The scoring tool will automatically display the correct chromophore to the 
question being asked.  In order to proceed through the scoring tool select the 
appropriate answer to the question, this will automatically load the next one.  
For each question a set of example SIAscans has been provided for reference. 
To access an example SIAscan navigate to the Example 1 button.  This will 
display the example image on the screen in place of the patients SIAscan, 
repeat as necessary for the other example images. To return to the patients 
SIAscan Click on the Current button.  On completion of the steps a Summary 
pane will appear with an overall score for the lesion and a recommendation as 
to whether the lesion is suspicious or not.  
 
The Hunter Scoring System (Primary Care SIAscopy algorithm) is shown below. 
This shows the decision making path and outcome along with how a score is 
calculated and is taken directly from the poster associated to the scoring 
system. 
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3.11 Saving and Printing a Report 
 

Select patient and scan you want to print/save the report for.  Click on the 
Report tab to open a new window. 
 

 
 

Select the type of the report, Patient or Detailed and click Generate. 
 

 
 
This will open the “Save Report as” window.   
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Chose the location where you want to save and rename the file if necessary 
and click Save. The report is saved in PDF format in a location you have 
specified. 
Now you can view, print or email your report. 

 
All data should be backed up on a regular basis in order to reduce the 
risk of loss of data. 
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3.12 Saving/Exporting SIA file 
 

If you wish to export SIA file images you can do so by using Export feature. 
Select patient and scan you want to export .SIA file for.  Click on the Export tab 
to open a new window. 
 

 
 

 
 
Select the location where you wish to save the file to and re-name the file if 
necessary before clicking on Save button.  
If you wish to send the .SIA file electronically, simply attach or upload the files 
accordingly.   

NOTE: The receiver must have SIMSYS application installed.  
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Upon receipt of the .SIA file, the user needs only to double-click on the .SIA file 
icon and it will automatically open up in SIMSYS. Image quality will be identical 
as if the SIAscan was taken by the end user or operator.  

 
3.13 Importing Images into a Mole or Lesion Record 
 
The clinical image in jpg, jpeg or png format could be imported to Images 
section and added to the report. Click on Import Image to add clinical image of 
the mole or lesion and Browse your files and click on Open to save the file to 
SIMSYS. Or you can use “drag and drop” technique to add clinical images here. 
 

 
 
To include the clinical image on the PDF report select both SIA image and 
clinical image (hold “CTRL” button while clicking on each file) and then click on 
Report to save Patient or Detailed report (see section 3.11 Saving and Printing 
a Report). 
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3.14 Importing Other Documents into the Patient Record 
 
Click on Import File to add any pre-existing file relevant to the patient.  Files of 
any format can be dropped into the record. 
 

 
 
To remove any record from documents or from the Body Map view, click on the 
item to select and click on Remove. Confirmation window will pop-up before 
the file is deleted. 
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4.0 CARE & MAINTENANCE OF SIMSYS SYSTEM 
 
Use Windows to Shutdown SIMSYS & PC 
 
Data corruption can occur if power is suddenly removed from the system.  
Always use Windows to turn off your computer.  
 
Care During Operation 
 
Before each patient examination, wipe the handset lens with an Isopropyl 
wipe.  A Lens Cleaning Cloth is provided with each device. 
 
Usage Conditions 
 
The SIAscope should only be used in the following conditions: 
 

 Temperatures between 10°C and 40°C, 

 Relative humidity between 30% and 80%. 
 
The SIAscope should NOT be used in the following conditions:  
 

 In direct sunlight and very brightly lit rooms, 

 In areas of dust concentration, and 

 In areas of extreme vibration. 
 
The SIAscope is not intended for use in areas of high electromagnetic radiation 
(e.g. MRI and CT scanning rooms)  
 
Transport and Storage 
 
The SIAscope should be stored and transported in the following conditions: 
 

 Temperatures between 10°C and 40°C, 

 Relative humidity between 30% and 80%. 
 
The Matching Fluid should be stored and transported in the following 
conditions: 
 

 Temperatures between 10°C and 40°C, 

 Relative humidity between 30% and 80%. 
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Matching fluid should be used within the use-by date indicated on its label. 
 
Maintenance and Calibration  

 
In order to ensure optimal performance of your SIAscope V unit, it is 
recommended that it be sent to the manufacturer or authorized service centre 
annually for maintenance and calibration.  No maintenance or calibration is to 
be performed by unauthorized personnel. 
 
Disposal of Device 
 
At the end of its service life, the SIAscope should not be disposed of in the 
general waste.  You should consult your local regulations for the proper 
disposal of medical electronic devices in your area.  Alternately, the SIAscope 
may be returned to MedX for disposal (see address on back cover). 
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5.0 TROUBLESHOOTING 
 

There are a number of foreseeable faults or problems that may affect the 
operation of SIMSYS.  These problems are often easy to solve.  The following 
table highlights these problems, suggests a check to diagnose them and then 
suggests an action to amend the fault. 
 

Problem Check Action 

Artefact on all scans.  The Handset window is 
clean.  

Clean the SIAscope window 
with an Isopropyl wipe.  

SIAscope V will not 
connect. 

Check that the SIAscope V 
has been connected 
properly to a USB 2.0 port.  

Try connecting to another 
USB 2.0 port.  

Droplets of water on 
the inside of the 
handset window.  

Are the droplets on the 
inside of the scanning 
window?  If not clean the 
window.  

If moisture is on the inside 
of the window, leave the 
handset in a warm room for 
the moisture to evaporate.  
If the problem persists then 
contact technical support.  

Viewfinder screen is 
black.  

Examine the handset and 
note if there is a white light 
emanating from the end 
and if the “SIA” button on 
the scope is lit up blue.  If 
there is not it is likely that 
the illumination has failed.  

Contact technical support.  

“The licence will 
expire in x days” 
message appears. 

 Contact MedX customer 
support to purchase a 
licence renewal. 
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6.0 TECHNICAL SPECIFICATIONS 
 

 Classification - Class II Medical Equipment (IIa for EU –             ) 

 Sensing technology - Spectrophotometric Intracutaneous Analysis  

 Sensor - Hand held sensor with an 11mm diameter sensing area, 
linked by a standard USB 2.0 cable to the system unit.  

 Emitted wavelengths - 440nm to 960nm  

 Resolution - Features larger than 25 microns  

 Scan time - Approximately 3 seconds data collection, 3 seconds data 
processing (depending on your computer) 

 Data display format - Processed data displayed as colour bitmaps 
(SIAscans) representing relative concentration and distribution of 
selected chromaphores.  

 Reference image format - Enhanced colour ELM (dermatoscopic) 
image.  Image calibrated for repeatability and optimized for maximum 
colour discrimination in both light and dark areas of the image.  

 Dimensions - 240mm in length x 65mm in diameter at its widest point.  

 Weight - 250g. 

 Viewfinder - Colour viewfinder mode allows accurate positioning of 
the sensor on the skin.  

 Hygiene - Easily disinfected sensor window. Wipe clean with an 
Isopropyl wipe before each scan.  

 Power supply - Power provided via the standard USB 2.0 connection. 
 

7.0 LIFETIME OF PRODUCT 
 

The SIAscope handheld scanner has been manufactured to exacting standards 
with high quality components to ensure excellent performance and durability.  
However, in the course of normal usage as laid out in this Operating Guide, 
normal wear and tear and degradation of such components could potentially 
affect the clarity of the images taken.  As manufacturers, we therefore state 
that the lifetime of the SIAscope is three (3) years. 
 

8.0 DECLARATION OF CONFORMITY 
 

MedX Health Corp. declares that the following medical devices: 
 

 SIAscope (model name: SIAscope V) 

 SIAscopy Software (model name: SIMSYS) 
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conform to the Medical Device Directive 93/42/EEC as amended by Directive 
2007/47/EC and comply with the following standards: 
 

 EN 60601-1: 2006/A1:2013 

 EN 60601-1-2: 2007 

 IEC 62471: 2006 

 IEC 62366: 2007 

 IEC 62304: 2006 

 IEC 60529:2001 

 ISO 10993-1:2009 

 ASTM D4169-16 
 
EC Certificate 543441 – Directive 93/42/EEC on Medical Devices, Annex V 
(Notified Body Number 0086) 
 

9.0 EMC REQUIREMENTS 
 

The SIAscope V is intended for use in the electromagnetic environment specified below.  The 
customer or the user of the equipment should assure that it is used in such an environment. 

Emissions test Compliance Electromagnetic environment - guidance 

RF emissions CISPR 
11 

Group 1 

The equipment uses RF energy only for its internal 
function. Therefore, its RF emissions are very low and are 
not likely to cause any interference in nearby electronic 
equipment. 

RF emissions 
CISPR 11 

Class A The equipment is suitable for use in all establishments 
other than domestic, and may be used in domestic 
establishments and those directly connected to the public 
low-voltage power supply network that supplies buildings 
used for domestic purposes, provided the following 
warning is heeded: Warning: This equipment/system is 
intended for use by healthcare professionals only. This 
equipment/ system may cause radio interference or may 
disrupt the operation of nearby equipment. It may be 
necessary to take mitigation measures, such as re-orienting 
or relocating the equipment or shielding the location. 

Harmonic emissions 
IEC 61000-3-2 

Class A 

Voltage fluctuations/ 
flicker emissions 

IEC 61000-3-3 
Complies 
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The SIAscope V is intended for use in the electromagnetic environment specified below.  The 
customer or the user of the Equipment should assure that it is used in such an environment. 

Immunity test 
IEC 60601 test 

level 
Compliance level 

Electromagnetic environment - 
guidance 

Electrostatic 
discharge (ESD) 
IEC 61000-4-2 

±6 kV contact 
±8 kV air 

±6 kV contact 
±8 kV air 

Floors should be wood, concrete or 
ceramic tile. If floors are covered 
with synthetic material, the relative 
humidity should be at least 30 %. 

Electrical fast 
transient/burst 
IEC 61000-4-4 

±2 kV for power 
supply lines ±1 kV 
for input/output 

lines 

±2 kV for power 
supply lines ±1 kV 
for input/output 

lines 

Mains power quality should be that 
of a typical commercial or hospital 
environment. 

Surge 
IEC 61000-4-5 

±1 kV line(s) to 
line(s) ±2 kV line(s) 

to earth 

±1 kV line(s) to 
line(s) ±2 kV line(s) 

to earth 

Mains power quality should be that 
of a typical commercial or hospital 
environment. 

Voltage dips, short 
interruptions and 

voltage variations on 
power supply input 

lines 
IEC 61000-4-11 
UT = 230 Vac 

<5 % UT (>95 % 
dip in UT) for 0,5 
cycle 40 % UT (60 
% dip in UT) for 5 

cycles 70 % UT (30 
% dip in UT) for 25 

cycles 
 

<5 % UT (>95 % 
dip in UT) for 5 sec 

<5 % UT (>95 % 
dip in UT) for 0,5 
cycle 40 % UT (60 
% dip in UT) for 5 

cycles 70 % UT (30 
% dip in UT) for 25 

cycles 
 

<5 % UT (>95 % 
dip in UT) for 5 sec 

Mains power quality should be that 
of a typical commercial or hospital 
environment. If the user of the 
equipment requires continued 
operation during power mains 
interruptions, it is recommended 
that the equipment be powered 
from an uninterruptible power 
supply or a battery. 

Power frequency 
(50 Hz and 60 Hz) 

magnetic field 
IEC 61000-4-8 

3 A/m 3 A/m 

Power frequency magnetic fields 
should be at levels characteristic of a 
typical location in a typical 
commercial or hospital environment. 
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The SIAscope V is intended for use in the electromagnetic environment specified below.  The 
customer or the user of the equipment should assure that it is used in such an environment. 

Immunity test 
IEC 60601 test 

level 
Compliance level 

Electromagnetic environment - 
guidance 

Conducted RF 
IEC 61000-4-2 

 
 
 
 
 
 
 
 
 
 
 
 
 

Radiated RF 
IEC 61000-4-3 

 
 
 
 
 
 
 
 
 
 
 
 

3 Vrms 150 kHz to 
80 MHz 

 
 
 
 
 
 
 
 
 
 
 
 
 

3 V/m 80 MHz to 
2,5 GHz 

 
 
 
 
 
 
 
 
 
 
 
 

 
3 Vrms 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 V/m 
 
 
 
 
 
 
 
 
 
 
 
 

Portable and mobile RF 
communications equipment should 
be used no closer to any part of the 
equipment including cables, than the 
recommended separation distance 
calculated from the equation 
applicable to the frequency of the 
transmitter. 
 
Recommended separation distance 

 

 
 

 
 

 
 

where P is the maximum output 
power rating of the transmitter in 
watts (W) according to the 
transmitter manufacturer and d is 
the recommended separation 
distance in meters (m).  Field 
strengths from fixed RF transmitters, 
as determined by an electromagnetic 
site surveya should be less than the 
compliance level in each frequency 
rangeb. 

Interference may occur in the vicinity 
of known RF transmitting devices and 
equipment marked with the following 

symbol:  

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 
 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from 
structures, objects and people. 

a) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, 
amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the 
electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured 
field strength in the location in which the equipment is used exceeds the applicable RF compliance level above, the equipment 
should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such 
as re-orienting or relocating the equipment. 
 

b) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 
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Recommended separation distances between portable and mobile RF 
communications equipment and the SIAscope V. 

The SIAscope V is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled. The customer or the user of the SIAscope V can help prevent 
electromagnetic interference by maintaining a minimum distance between portable and mobile 
RF communications equipment (transmitters) and the SIAscope V as recommended below, 
according to the maximum output power of the communications equipment. 

Rated maximum output 
power of transmitter 

[W] 

Separation distance according to frequency of transmitter 
[m] 

150 kHZ to 80 MHz 
 

 

80 MHz to 800 MHz 
 

 

800MHz to 2.5 GHz 
 

 
0.01 0.35 0.12 0.24 

0.1 1.11 0.37 0.74 

1 3.5 1.17 2.34 

10 11.07 3.69 7.38 
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10.0 ACKNOWLEDGEMENTS AND NOTICES 
 
SIA, SIAscanner, SIAscope, SIAscan, SIAscopy, SIAMETRICS, MoleMate, SIMSYS 
and Powered by SIAscopy are registered trademarks of MedX Health Corp. 
 
Microsoft and Windows are registered trademarks of Microsoft Corporation. 
 
The information contained in this manual is subject to change without notice. 
 
MedX Health Corp. makes no warranty of any kind with regard to this material, 
including but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose. 
 
MedX Health Corp. shall not be liable for any errors or for incidental or 
consequential damages in connection with the furnishing, performance, or use 
of this material. 
 
All rights reserved.  Reproduction, adaptation, or translation of this document 
is prohibited without prior written permission of MedX Health Corp., except as 
allowed under the copyright laws. 
 
No part of this document may be photocopied, reproduced or translated to 
another language without the prior written consent of MedX Health Corp. 
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11.0 REVISIONS 
 
 
 

Table A.1. Revisions 

Revision No Revision Description Date 

Revision 0.1 First draft composed. 10/03/2009 

Revision 0.2 Biocompatibles changes. 16/04/2010 

Revision 0.3 MedX Health changes. 15/02/2012 

Revision 1.0 
Reformatting of manual and addition of 
installation instructions, warnings and 
EMC requirements. 

21/10/2013 

Revision 1.1 
Change of address for manufacturer and 
EU Rep. 

28/04/2014 

Revision 1.2 
Added clinical image to reports, rotation 
feature and some other minor software 
changes 

20/05/2015 

Revision 1.3 
Added software language selection and 
Mark the lesion feature 

05/10/2015 

Revision 1.4 Added CE0086 label to the manual 14/01/2015 

Revision 1.5 

Replaced applicable symbols with ones 
conforming to harmonized standards for 
medical device symbols. 
Added computer and OS system 
requirements to indicate Windows 10 
compatibility. 
Standards applied – updated. 
Added note about safely terminating 
application. 

19/10/2016 
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Revision 1.6 

New feature added i.e. exporting .SIA file 
 
Added on Sec 1.6  new symbols:  EC REP 
and LOT 
On Sec  9.0, indicated EC certificate 
number and corrected  MD directive 
number to 93/42/EEC. 
Updated information on compliance to 
latest issue/edition of following standards:  
EN 60601-1,;  ISO10993-1, and  ASTM 
D4169, Added IEC 60529:2001,  
  
Change of Authorized EU Rep, from TGM 
Medical Technology Consultants Ltd. in 
Berkshire, UK,  to AJW Technology 
Consulting GmbH with office in 
Dusseldorf, Germany. 
 
Added required information pertaining to 
the  newly-designated Australia Sponsor: 
Pharmadev Consulting Pty Ltd. with office 
in Sydney, NSW, Australia 
 
Added  MedX Health Corp email address 
as part of company contact information  
  
Pg.9 Changed length of the USB cable 
supplied from 1.83m (6’) to 3m (9.84’) 
 

31/10/2017 

Revision 1.7 

Separated Installation Guide from 
Operating Guide 
Addded New Zealand sponsorship to 
Pharmadev Consulting Pty 

14/3/2018 
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The product described herein incorporates copyright protection technology that is protected by method and 
device claims of certain U.S. and Worldwide patents and other intellectual property rights owned by MedX Health 
Corp., and other rights owners.  Use of this copyright protection technology must be authorized by MedX Health 
Corp., and is intended for clinical and other limited viewing uses only unless otherwise authorized by MedX Health 
Corp. Reverse engineering or disassembly is prohibited 
 
Method and apparatus Claims of U.S. and Worldwide Patent numbers: US6324417, US7916910, US2008075340, 
WO9822023, WO0075637, EP2393063, EP1768060, EP1185853, EP1006876, JP4856872, JP2001504020, 
JP2003501651, JP2007190364, GB2334099, GB2367125, GB2429385, GB2439469, CA2272290, CA2560364, 
AU2006220441, AU2006220441, AU4961597, AU5232100, AU725766 licensed for limited viewing uses only. 
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MedX Health Corp. 

1495 Bonhill Road, Unit 1 

Mississauga, Ontario 

Canada     L5T 1M2 

Ph: +1 905 6704428 

TF: 1 888 363-3112 (Canada and USA only) 

email: info@medxhealth.com 

website: www.medxhealth.com 
  

 

EU Authorized Representative 

AJW Technology Consulting GmbH 

Königsallee 106 
40215 Düsseldorf 

Germany 

Email:ECRep@ajwtech.com 

 

Australia & New Zealand Sponsor 

Pharmadev Consulting Pty 

Level 12, 95 Pitt Street 

Sydney, NSW 2000 

Australia 

Email:pharmadev@ajwtech.com 
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